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INSTALLATION
Place the ToCA Race Driver™3 disc in your DVD drive and close the disc tray. Wait a few 
seconds for the drive to initialise. If you have Autorun enabled on your PC, ToCA Race 
Driver™3 will automatically begin to install. If you don’t have Autorun enabled, go to the 
Windows® Start Menu and select RUN. Type D:\setup (replace ‘D’ with the letter of your 
DVD drive) and hit (ENTER).

The installation program will initialise; follow the on-screen instructions to progress 
through the installation. ToCA Race Driver™3 requires the presence of DirectX 9.0c on your 
system. You will be given an option to set up DirectX 9.0c during installation if required. 

During installation, you will also be given the opportunity to register your game online.  
This is not a requirement – you can register your game at any time following installation at  
www.codemasters.co.uk/register. 

If you are using a dialup connection to access the Internet, but do not have this configured 
to activate automatically on request, you may need to initiate your connection prior to 
beginning installation if you want to register online.

It is advisable to have no other programs (other than those required to access the Internet) 
running on your PC during installation.
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GAME CONTROL

STEERING WHEEL CONTROLLERS

This game supports the use of the Logitech GT Force, Driving Force, Driving Force Pro and 
Momo USB Steering Wheel controllers.

If using a USB steering wheel controller, ensure that it is connected before pressing the 
START button to begin the game. Press START button on the relevant controller, which 
must be used thereafter during that session.

If your USB steering wheel controller supports multi-turn mode, this can be activated 
through Options > Driving. For full controller configurations please see Options > Driving 
> Control Assignments.

Menu Navigation

Highlight Menu Item: Arrow Keys
Change menu option where available: Arrow Keys
Select highlighted menu item: (ENTER)  (where applicable)

Cancel/exit menu: (ESC) (where applicable)

Other keys are also used to navigate 
through some of the menu screens. 
The button bar along the bottom of 
the screen indicates which 
buttons to use.
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STARTING THE GAME

Player Profile 

Once the game has loaded, either select an existing player profile or create a new one. 
You will need to create a new profile if you are loading the game for the first time.

Creating a New Profile

First select a save slot to store your profile in. As you continue through your driving career, 
all of your progress and the features that you have unlocked will be saved to this profile.

Next set up your profile details and then select ‘Done’. Finally complete your profile by 
defining your game options (see Options for more information). When you have finished, 
select ‘Begin’ to start your career.

Your Racing Career

This is your chance to make a name for yourself in the racing world. Along the way you will 
take part in a wide range of very different championships featuring a wealth of cars, each 
providing unique challenges.

Success will not come easily. Not only will you have to adapt to very different racing 
styles, you will also have to be aware of other drivers who want to claim the crown for 
themselves.

The World Tour mode is where it all starts 
and making your way up the career ladder 
is one of the ways that you can unlock 
more vehicles and tracks that you can 
then use in the other game modes.

In Pro Career mode you earn cups for 
winning each of the championships. 
One cup is awarded for completing the 
championship in normal mode, another 
for hard mode and one for setting the 
fastest lap on each of the tracks in that 
championship (time trial only). These 
cups can then be used to unlock additional 
bonus content.

The World Tour mode is where it all starts 
and making your way up the career ladder 
is one of the ways that you can unlock 
more vehicles and tracks that you can 

In Pro Career mode you earn cups for 
winning each of the championships. 
One cup is awarded for completing the 
championship in normal mode, another 
for hard mode and one for setting the 
fastest lap on each of the tracks in that 
championship (time trial only). These 
cups can then be used to unlock additional 



THE GAME SCREEN

1. Lap Indicator: Number of laps completed so far.

2. Position Indicator: Your current position in the race.

3. Current Time Indicator: The total race time elapsed so far. 

4. Lap Time: The time elapsed so far on your current lap.

5. Best Time: Shows your record lap time for the current track. 

6. Accelerator/Brake Gauge:  The amount of force applied to the accelerator/brake pedal.

7. G Meter: Shows the amount of g-force currently being generated.

8. Gear Icon: Your currently selected gear.

9. Fuel Gauge: The amount of fuel remaining in your tank.

10. Speed: Your speed in miles per hour.

11. Mini Map:  Your position and the position of your nearest competitors 
on the current circuit. Your car appears as an arrow.

12. Stage Progress: Shows your progress through the Rally Stage.

13. Split Time:  Represents the fastest recorded time through each section 
of the rally. If it’s green you are currently the fastest, if it’s 
red then a quicker time has been recorded.         

14.  Rally Corner Indicator: Indicates the direction of the road ahead.

15. Damage Indicator:  Illuminates from yellow (minimal) through to red 
(serious) as components of your car start to become 
damaged. You are able to repair your car in the Pits 
(where available) but if your car becomes seriously 
damaged to the point that you are unable to complete the 
race, you can opt to retire (via the Pause Menu).

Although all vehicles suffer damage they are all affected differently. For example 
Open-wheel cars are much more fragile and more susceptible to damage to their tyres and 
wheels. Trucks on the other hand are much more robust and can take much more punishment. 
It is important to be mindful of these differences and adapt your racing style accordingly.

Note: If you receive terminal damage and components can no longer function then you 
are automatically retired from the race.
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DAMAGE

GEARS

Damage to your gearbox can prevent your car from reaching its top speed. 
Damage to this component can also reduce your ability to change from gear 
to gear. The gearbox can be damaged by either the player changing down 
incorrectly through the gears (in manual mode), or by a head-on impact.

STEERING

Steering damage will reduce vehicle responsiveness. Severe damage will 
cause the vehicle to pull in one direction, making it difficult to control at 
high speeds. The steering can be damaged by front or side-on impacts, or 
by driving the vehicle across the infield at high speeds.

SUSPENSION

Suspension damage will affect road holding and cornering ability. 
Severe damage will increase the possibility of the car bottoming out. 
The suspension can be damaged by the vehicle being involved in impacts or 
by the player driving the vehicle across the infield areas at high speed.

ENGINE

Engine damage will seriously reduce vehicle performance, reducing top 
speed and acceleration. Engine damage occurs during collisions and once 
damaged, the time taken for the engine to overheat will decrease. A bar 
underneath the engine icon shows its current temperature. 

WHEELS

Damage to the wheels reduces the stability and handling of the car. The loss 
of a wheel can lead to you being unable to complete the remainder of the 
race. A bar underneath the wheel icon shows the current tyre temperature. 

TYRE WEAR

As tyres wear down they begin to lose grip on the track surface. Driving 
across the infield will wear down tyres faster and should be avoided.
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Damage to cars’ bodywork is not purely cosmetic. It also 
affects the aerodynamic profile of the car, which in turn 
impairs its ability to reach its top speed. Damage to the 
wings will also have a serious impact on handling.
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MAIN MENU — OVERVIEW

The Main Menu is where you can start your motor-racing career. Here you can access the 
Simulation modes as below, as well as the main World Tour and Pro Career modes described 
later on pages 12 & 14. World Tour gives you the freedom to jump from one motorsport discipline 
to another with less emphasis on rules and flags, whereas Pro Career focuses on truly mastering 
an individual motorsport at a time.

Simulation Modes

In the Simulation Menu you can choose from the following options: 

Free Race: This mode allows you to play through any of the Championships 
that have been previously unlocked in World Tour or Pro Career mode. In Free Race 
you can set up the Championship to your own specification, down to the smallest of 
details such as selecting which tracks to race on, which rules and flags will be used, 
which opponents to race, etc. You can also elect to switch on full race events, and play 
through the entire Race Calendar for that Championship, including all of the practice 
and qualifying sessions.

Select Discipline: Scroll left or right to select which discipline you want to 
race in. Above each discipline is a description detailing what sort of racing to expect.

Championship Select: After selecting the discipline you are now 
ready to start setting up your Championship. Scroll left/right to select the type of 
Championship that you want. You can then select which tracks you would like to race 
on, or select to race on the entire calendar. Once you are happy with the selected 
tracks you can choose which car you would like to use.

Championship Set-up: Having selected the type of race, the tracks and 
the car you wish to use you can now adjust the finer details of your Championship. 
It is here that you can turn on/off which rules or flags you wish to have, as well as 
changing the number of laps, how many opponents will be competing with you, how 
you want grid position to be determined.

Time Trial: Use time trial to set your best lap times on any of the circuits that you 
have unlocked from any of the Championships.

Multiplayer: A chance to play on any of the circuits in two-player split-screen mode. 
Both players need to press ‘start’ to join the game, then Player 1 selects the options as in 
Free Race mode. The race commences once Player 2 has selected their car.
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Network

Select ‘Network’ to start or join a multi-player game across a Local Area Network (LAN). 

Join: Enter the lobby of a game that has been created on another PC connected to 
your LAN by selecting one of the sessions shown in the on-screen list. Change your 
car, team and driver if you wish and once you are happy with your selection press 
(F1) to ready yourself. Once the host has selected ‘Ready’ anyone who is not ready 
will have 15 seconds to press ready before the race begins.

Create: Use the options shown on screen to define the parameters of the game you 
are hosting. When you are finished select ‘Start Session’ to go to the race lobby. Your 
game will appear on the Join List of any PC’s running the game on the same network. 
You can change the session settings and which championship to race on and which 
cars to use from the lobby menu, by returning to the Session Settings menu. 

 When you are ready to hit the track, select ‘Ready’. This starts a 15 second 
countdown to race start, visible on all players’ screens. Players who do not select 
ready before the countdown ends will be left out of the race.

Enter IP: Enter the IP Address of a PC hosting Race Driver 3 on your LAN. 

Network Options: Use ‘Network Options’ to redefine your player name and 
configure your connection speed. 
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Elimination Mode: A new and exciting online mode. At 
the end of each lap, the player or players who are last 
over the finishing line will be disqualified. The winner 
of the game is the last car remaining on the track. 
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PLAY ONLINE
Select ‘Play Online’ to take part in a multiplayer game across the internet. The first time 
you play online you must create an account in GameSpy. Select ‘New Account’ and follow 
the directions on-screen to do this.

Choose ‘Select Account’ to play online using a previously created account.

Quick Game: Quick Game is the fastest and easiest way to get into a game.  
It finds the first game running that you are able to join. Select ‘Join’ to enter the 
game displayed, or ‘Find Next’ to bring up the next available game.

Browse Sessions: Use this option to specify exactly what type of game  
you would like to join. Use the navigation controls to define the criteria for your game 
search, and then select ‘Search’ to display a list of games running that match your 
preferences. Highlight a game on the list and press  (ENTER) to join the lobby  
of that game.

Create Match: Select ‘Create Match’ then follow the options on screen to set 
up your own online game for other players to join. 

Lobby: Before the start of an online race all players enter the lobby to prepare.  
From here you can choose your team/car. The host can also decide whether they 
want Full Race Rules and Flags to be used in the session or not. Once you are happy 
with all the selections that you have made select ‘Ready’ to indicate to the host of 
the game that you have finished setting everything up and are raring to go. If any 
players are not ready 15 seconds after the host has selected ‘Ready’, the game will 
begin regardless of whether other players have selected ‘Ready’ or not.

Spectator Mode: If you join a game session where others are already 
racing you can watch the progress of their race by pressing (F1).



OPTIONS

Profile

Select Profile to give yourself a name that can be used in career and other race modes.  
You can also select which language you want the game to be displayed in as well as your 
nationality.

Driving

Select ‘Driving’ to define your driving style and controller preferences.

Control Assignments:  To re-define a control, highlight the function 
name and press  (ENTER), then press 
whichever button you want to re-assign to that 
function. If at any point you want to restore 
everything back to the default settings, select 
‘Reset to Default’ .

Advanced:  Adjusts your controller’s dead zone and 
saturation settings.

Force Feedback/ 
Force Level: Configure force feedback for  
 enabled controllers.

Gearbox:  Select ‘Automatic’ and gears will change 
automatically – great for novices. 
 
Select ‘Manual’ to give you full control over 
when you change gear. 
 
Select ‘Manual with Clutch’ for complete 
driving control – for very experienced drivers.

Pro-Simulation:  Turning on any of the Pro-Simulation handling 
options makes the whole driving experience 
much more realistic and therefore much more 
difficult. These options should only be turned on 
if you are a very confident driver.
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Graphics:  Select Graphics to determine which on-screen 
display elements you wish to have ‘on’ or ‘off’.

Sound:   Select Sound to set the Volume of the various 
sound elements.  

Bonus:  Select Bonus to enter or activate any Bonus 
Codes you have. See the back of the manual for 
how to obtain these codes.

Network:  Change any of the available Network 
Configuration Options .

Pro-Simulation Handling:  With this turned on your car 
will not only be more tricky to drive it will also suffer 
from much more realistic damage. This mode is for elite 
drivers who want the full authentic experience



WORLD TOUR

Overview 

World Tour mode offers you a motorsport career taking you through a wealth of different 
championships. Your career will begin with the chance to compete in one of two opening 
motorsports on offer: the Global GT Lights and the Autosport Clio Cup. Success in these 
championships will enable you to climb the career ladder, getting an opportunity to take 
part in a diverse selection of motorsport such as the British GT, DTM and V8 Supercar 
Championship Series. Success in these will ultimately provide you with the chance to drive 
for the BMW WilliamsF1 Team.

Meet Rick 

Rick will manage you as you make your way through your career. 
He will keep you on your toes and make sure you are getting the best 
out of the cars you will be competing in. Whilst you are racing he will 
keep in contact with you through the pit radio, letting you know about 
any problems and relaying important info to you. Be warned though, 
Rick doesn’t pull any punches! He will tell it to you just how it is, so 
the only way to keep him happy is to keep on winning all of those 
Championships!

Tiers 

The mode consists of multiple tiers. Within each tier you have several 
championship options to choose from. There is always a choice of 
at least two championships and in most cases there are three. 
There is an exception to this rule; the last two tiers consist 
of championships featuring WilliamsF1 challenges where 
there are no other choices.
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Flexibility 

In World Tour you can progress your career up and down through the tiers that you have 
already completed. In order to qualify for a new tier you must complete at least one of 
the objectives on the previous one. Once you have completed a championship you unlock 
it along with the car that you raced and the tracks that you raced on. It is also possible to 
unlock tiers by competing in online races.

Championships

All of the main championships featured in the game are in the World Tour mode. 
The championships do not all feature the full race calendars and formats. If you want to 
play races with full Calendars and rules head over to the Pro Career mode. 

Pit Stops

If your car is suffering from damage or you are running low on fuel it is time to come 
into the pits. For each repair there is a time allocated so you can see how long it will take. 
In addition an overall pit stop time is given. You can alter the time of the pit stop by 
changing the level of repairs and how much fuel is going into the car. In certain 
Championships there will be mandatory pit stops. This means that you must come into 
the pits to either change your tyres or refuel. Rick will tell you which laps you should 
come in on.

13



14

PRO CAREER MODE 

The Pro Career mode allows you to pick a motor racing discipline and play through each 
championship in a realistic manner with full race rules, calendars, flags etc.

The classic discipline allows you to compete in some of the most famous 
racing cars ever raced. From the 1930s championship winning Mercedes 
W25 to the powerful muscle cars of the ‘70s.

 

Race some of the most prestigious and exotic sports cars in the GT 
discipline. Take part in multi-class races, and get to grips with some of the 
most powerful racing cars in the world of motorsport.

From dirt ovals, to  Indianapolis Motor Speedway, experience the excitement 
of the world’s fastest professional motor sport.

The Touring Car discipline is about aggressive, high-octane, pack racing. 
Ultimately aiming to earn a place in either the DTM or V8 Supercar 
Championship Series.

From Rally, to Baja, Nissan Dakar to Rally Cross, experience every level of 
Off Road racing in the Off Road discipline. The challenge in this thrilling 
style of racing is to not only master your vehicle, but also the environment.

Perhaps one of the most technically difficult disciplines, Open Wheel 
demands that drivers fully understand the nuances of each track and 
vehicle. The secret here is all about the racing line, and taking great care to 
avoid contact in these fragile machines.

Compete in a series of time trial events at the 400-acre Bedford Autodrome 
Complex. Each event takes place in a different car and circuit at the site.

This discipline features a selection of unique and challenging  
Championships, pitting players in a number of different Honda cars  
and vehicles.
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RULES AND FLAGS 

In Free Race and Pro Career mode you can opt to use full race rules and flags. Below is a list 
of the flags used in the game and what they indicate. These flags and the rules associated 
with them can be turned on or off on the Championship Set-up screen.

Commonly referred to as the passing flag and indicates that a driver should 
be aware of a faster car attempting to lap them.

The black flag indicates that the driver has received either a timed or pit 
penalty.

The Yellow Flag is displayed as a warning of an accident ahead.  Overtaking 
is forbidden whilst the yellow flag is out.

The green flag (waved after yellow) signals the end of a caution period. 
Drivers can resume to race speed.

The white flag indicates that the driver has commenced their last lap of 
the race or can mean (in certain championships) that there is a much 
slower vehicle on the sector of track controlled by that flag post.

A black and white diagonally divided flag is shown to drivers for 
unsportsmanlike behaviour on the track, such as careless driving or 
corner cutting. 

A black flag with an orange circle is shown to drivers whose vehicles have 
mechanical problems. Drivers shown this flag must return to the pits as 
soon as possible.

Shootouts: In some Championships after the initial 
qualifying round a shootout (or Super-Pole in DTM) 
takes place. This is when the top ten drivers from the 
first qualifying round complete a single timed lap, 
which determines the top ten places on the grid.



CAR TUNING
In Time Trial, Free Race and Pro Career modes you can tune your vehicle to adjust its 
performance. Although races can be won by just using the standard settings in order to 
set the very best lap times you may find that you need to tweak your settings slightly. If 
you press (F1) after selecting any of the components, you will be provided with a detailed 
description of the ways in which they affect your car. 

Note: Car Tuning is not available in all Championships and not all set-up options will be 
available to all vehicles. 

Downforce: Downforce is created when air is channelled over the vehicle body. 
Downforce increases grip, but also increases drag, which can reduce top end speed. 
To adjust downforce highlight the front or rear of the car and use the left/right 
arrows to adjust the setting of each.

Transmission: In order to get the best acceleration the gears need to be set 
very close together, this however reduces the car’s top speed dramatically.  
In turn spacing the gear ratios out improves the cars top speed but greatly reduces 
acceleration. To adjust your gears highlight each one individually and adjust its values.

Anti Roll: An anti-roll bar is a metal bar that links both wheels on the same axle 
to the chassis making it harder for the driver-side and passenger-side suspensions 
to move in opposite directions. This reduces the vehicles roll and greatly increases 
its grip. To adjust anti roll highlight the front or rear of the car and use the left/right 
arrows to adjust the setting of each.

Tyre Compound: Tyre compound is a measure of how hard or soft the tyre is. 
Softer tyres afford more grip but wear out quicker and provide slightly less steering 
response. Harder tyres produce less grip but last much longer and give slightly 
better steering response. To adjust your tyre compound move the slider left or right 
depending on whether you want it to be hard or soft. 

Tyre Profile: Tyre profile is the measurement from the outer edge of the tyre 
to the inner rim. Compared to conventional passenger car tyres, low profile car tyres 
have greater width ratio to cope with the demands of higher performance vehicles.  
To adjust your tyre profile highlight the front or rear of the car and use left/right 
arrows adjust its values.

Brake Bias: Adjusting brake bias affects the way that your vehicle handles in 
the bends. When you decelerate, the weight of your car is forced forwards onto the 
front wheels. This will increase frontal grip but will make the back of your vehicle 
light. This can improve steering into tight corners as it will help to shift the back of 
the car around, but combined with too much speed it can easily send your car into an 
uncontrollable spin. 
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Care is needed in putting too much bias on the front wheels as it can make your 
brakes lock more easily, and when this happens it is impossible to steer. To adjust 
your brake bias move the slider left or right depending on whether you want it to be 
toward the rear or the front of the car. 

Ride Height: Adjusting ride height changes the working range of the car’s 
suspension. A high ride height gives the greatest range to the shocks, but also 
increases the likelihood of body roll along with reduced downforce and grip. To 
adjust the ride height, highlight the front or rear of the car and use the left/right 
arrows to adjust the values of each.

Suspension: Suspension affects the car’s road holding abilities and the ability 
to handle cornering at speed. Setting the suspension to ‘soft’ will allow the car to 
cope better with uneven surfaces, as each wheel is able to maintain contact with the 
ground for longer. If it is too soft though your car will be susceptible to body-roll on 
bends. Hard suspension improves your corner taking ability, but on rougher terrain 
you will find your grip markedly reduced. To adjust the suspension highlight the 
front or rear settings and use the left/right arrows to adjust the values of each.

Toe and Camber: When the wheels are set so their leading edges are 
pointed slightly towards each other they are said to have toe-in. If they are set 
pointing away from each other they are said to have toe-out. Toe settings affect tyre 
wear, straight-line speed and stability, and there is a trade-off between the straight-
line stability afforded by toe-in and the quick steering response promoted by 
toe-out. To adjust the toe, highlight the front or rear settings and use the left/right 
arrows to adjust the values of each.

 Camber is the tilt of the tyre as viewed from the front of the car. If the tyres tilt 
toward the centre on the car you have negative camber and if it tilts away from the 
centre you have positive camber. Adjusting camber can have a dramatic effect on the 
steering of the car. To adjust the camber, highlight the front or rear settings and use 
left/right arrows to adjust the values of each

. 
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CAR UPGRADES 

In certain Championships you are able to upgrade the various components of the car.  
Such upgrades increase the overall BHP of the car, (at the expense of fuel efficiency) brake 
strength, engine performance, structural stability, etc.  To install the upgrade that you want, 
scroll left or right to highlight it and press (ENTER) to install. Below each icon it tells you how 
many slots each upgrade will take. The total upgrade slots you have available are shown in 
the top left of the screen. If you press (F1) on this screen it will provide you with a detailed 
description of how the various upgrades affect the performance of the car.

Induction Kits:  Increase BHP - Decrease Fuel Efficiency

Brake Kits: Increase brake strength

Brake Hoses:  Increase brake strength

Cams:  Increase BHP - Decrease Fuel Efficiency

Clutches:  Increase BHP

Dump Valves:  Increase BHP

Electronics:  Increase BHP - Increase Fuel Efficiency

Engine Tuning:  Increase BHP - Increase Fuel Efficiency

Engine Hoses:  Decrease engine overheating

Exhausts:  Increase BHP - Increase Fuel Efficiency

Flywheels:  Increase BHP - Increase Fuel Efficiency

Ignition Kits: Increase BHP - Increase Fuel Efficiency

Intercoolers:  Increase BHP – Decrease Fuel Efficiency
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Oil Coolers: Decrease engine overheating

Roll Cages:  Increase performance and resistance 
to mechanical damage

Seats: Increase structural stability

Strut Braces:   Increase performance and resistance
to mechanical damage

Suspension Kits:  Decrease suspension damage

Transmission Kits:  Increase Gear Speed and performance

Turbochargers:  Increase BHP – Decrease Fuel Efficiency

Tyres:  Increase traction and decrease tyre wear

Wheels: Decrease axle and tyre damage

TELEMETRY
After completing a qualifying 
session or test drive on any track 
you can view the telemetry data, 
which shows your speed at each 
part of the track, as well as when 
you were applying the brake or 
throttle. You can then compare 
data from previous attempts to 
find areas where you can improve. 
Pressing (F1) zooms in so you can 
see the data in more detail and 
(F2) is used to load the car tuning 
data from previous attempts.

After completing a qualifying 
session or test drive on any track 
you can view the telemetry data, 
which shows your speed at each 
part of the track, as well as when 
you were applying the brake or 
throttle. You can then compare 
data from previous attempts to 
find areas where you can improve. 

zooms in so you can 
see the data in more detail and

 is used to load the car tuning 



THANKS TO 

Alan Docking Racing, Audi AG, Barry Pomfret, BMW, Classic Team Lotus, Dallara, 
Automobili s.p.a, Daimler Chrysler, Fiat Auto S.p.A, Fuji Heavy Industries Limited, 
Gemballa Automobil GmbH, General Motors, Graham Hathaway Engineering Ltd., JC 
Bramford Excavators Ltd, Jedi Racing Cars Ltd, John Mills Engineering Ltd, Koenig Specials, 
Marcos Sportscars Ltd, MG Sport & Racing Ltd, Mitsubishi Motors Corporation, Morgan, 
Mosler Automotive, Nissan Motor Company Limited, Noble Automotive Ltd, Renault 
Merchandising SAS, Strana Truck Association of North America, Svanda Motorsports, 
TVR Engineering Ltd., Ultima Sports Ltd, Williams Grand Prix Engineering Ltd, 
4Players GmbH, AS Auto Verlag GmbH and Axel Springer, Oz S.p.A., Prodrive UK, Sparco 
SpA, Suncor Energy Products, Nicky Grist Motorsport Ltd, Nimrod Productions.

Bahrain International Circuit, WA Sporting Car Club Inc, Bathurst Regional Council, 
Motorsport Vision, Castle Combe Circuit, Donington Park Leisure Ltd, Dover Motorsports 
Inc, Eastern Creek International Raceway, Hockenheim-Ring GmbH, Gold Coast 
Motor Events Co, Mazda Raceway Laguna Seca, Mondello Park Ltd, Motopark GmbH, 
Motorsportclub Nurnberg, Nurburgring GmbH, Oran Park Raceway Pty Ltd, PI Operations 
Pty Ltd, Melbourne Racing Club, Shanghai International Circuit Co. Ltd, Circuit of Spa 
Francorchamps, Exploitatie Circuit Zandvoort b.v.

Akrapovic d.o.o., Autocar Electrical Equipment, Auto Inparts, Avo Uk Ltd, Cooper-Avon 
Tyres Ltd, ThyssenKrupp Bilstein GmbH, Black Diamond Performance, Blitz UK, BMC s.r.l., 
Brembo S.p.A, Bridgestone Corp., Components Automotive 73 Ltd, Collins Performance 
Engineering, Dastek, Freeman Automotive UK Ltd, Heinrich Eibach GnbH, Federal Mogul 
Corporation, Fidanza Engineering, Corporation, Goodridge UK LTd, Good Year, Hella, Koni 
BV, Leda Suspension Ltd, Max-Torque Ltd, Milltek Sport, Mintex, Omex Technology Systems 
Ltd, OMP Racing R.r.l., Pace products (Anglia) Ltd, A&I(Peco) Acoustics Ltd, Penske Racing 
Shocks, Pipercross Ltd, Peter Lloyd Rallying, EPTG Ltd / Power Engineering, RT Quaife 
Engineering Ltd, Quickshift Racing, Raceparts(UK) Ltd, Red Dot Racing, ReVerie Ltd, 
Scorpion Exhausts, SPA Design Ltd, Sparco SpA, Superchips Incorporation, Supersprint, 
Toyo Tyre UK, Xtrac Ltd.

SPECIAL THANKS TO
Frauke Meyer, Christoph Hewer, WM GmbH, The Board Members of the ITR e.V.  
The DTM Championship and all of the teams, drivers, car manufacturers, circuits  
and sponsors associated with the series. Tracey Benton, Jenny Babbage, Basil 
Scaffidi. The Board Members of V8 Supercars Australia Pty Limited CAN 077 053 484,  
Australian V8 Supercar Championship and all of the teams, drivers, car manufacturers, 
circuits and sponsors associated with the series. Neil Vandegrift and Nicole Polsky, 
Indianapolis  Motor Speedway.
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CREDITS

This product is manufactured and distributed under license from International Management 
Group of America Pty Limited.

Trademarks, design patents and copyrights are used with the approval of the owner
 AUDI AG.

The BMW logo, the BMW WilliamsF1 logo, the BMW wordmark and the BMW model 
designations are Trademarks of BMW AG and are used under license.

Dodge is a trademark of DaimlerChrysler Corporation.

All Fiat cars, car parts, names, brands and associated imagery featured in this game are 
intellectual property rights including trademarks and/or copyrighted materials of Fiat 
S.p.A. All rights reserved.

The Buick Gran Sport 455, Chevrolet Silverado, Pontiac Firebird, Corvette C5 and Corvette 
C5R are General Motors Trademarks used under license to Codemasters Software 
Company Ltd.

Original Music Composed and Arranged by Nimrod Productions Limited 
www.nimrodproductions.com

DaimlerChrysler, Three Pointed Star in a Ring and Three Pointed Star in a Laurel Wreath 
and Mercedes-Benz are Trademarks of and licensed courtesy of DaimlerChrysler AG and 
are used under license to The Codemasters Software Company Ltd.

Renault Official License Products are vehicle models and trademarks protected by 
intellectual property laws. Used with permission from Renault. All rights reserved.

General Motors’ Vauxhall VX220 and Vauxhall Monaro, all related Emblems and vehicle 
body designs are Vauxhall Motors Limited Trademarks used under license to Codemasters 
Software Company Ltd.

Trademarks, design patents and copyrights are used with the permission of the owner 
Volkswagen AG.

“IRL”, “Indy Racing League”, “IndyCar”, “Indianapolis 500”, “Indy 500”, “Indianapolis 
Motor Speedway”and “The Greatest Spectacle in Racing” are registered trademarks of 
Brickyard Trademarks, Inc., used under license.

“Uses Bink Video. Copyright (C) 1997-2005 
by RAD Game Tools, Inc.”

21



NOTES 

22



23

ON YOUR MOBILE

TEXT GO CODIES TO 
85080 TO FIND OUT 

ABOUT OUR LATEST 
MOBILE GAMES. 

NORMAL SMS AND 

DATA CHARGES APPLY 

TEXT GO TOCA 
TO 85080 TO 

BUY TOCA 
RACE DRIVERTM3 

ON YOUR MOBILE.
NORMAL SMS AND 

DATA CHARGES APPLY
THIS IS NOT A 

SUBSCRIPTION SERVICE

Must be 16+ and have bill payer’s  
permission to order. 

Compatible WAP handset required. 
Codemasters terms and conditions apply. 

Helpline: 0870 7577881

The Codemasters Software Company Limited, PO Box 6, 

Royal Leamington Spa, Warwickshire, CV47 2ZT, United Kingdom.
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THE CODEMASTERS SOFTWARE COMPANY LIMITED  
SOFTWARE LICENSE AGREEMENT & WARRANTY

IMPORTANT - READ CAREFULLY: THE ACCOMPANYING PROGRAM 
(WHICH INCLUDES COMPUTER SOFTWARE PROGRAM, THE MEDIA 
AND RELATED DOCUMENTATION IN PRINTED OR ELECTRONIC 
FORM) IS LICENSED TO YOU ON THE TERMS SET FORTH BELOW, 
WHICH CONSTITUTES A LEGAL AGREEMENT BETWEEN YOU AND THE 
CODEMASTERS SOFTWARE COMPANY LIMITED. (“CODEMASTERS”). 
BY USING THE PROGRAM, YOU AGREE TO BE LEGALLY BOUND BY 
THE TERMS OF THIS AGREEMENT WITH CODEMASTERS.

THE PROGRAM is protected by the copyright laws of England, 
international copyright treaties and conventions and other laws. 
The Program is licensed, and not sold, and this Agreement 
confers no title or ownership to the Program or any copy thereof.

1. Limited Use License. Codemasters grants you the non-
exclusive, non-transferable, limited right and license to use 
one copy of the Program solely for your personal use. 

2. Ownership. All intellectual property rights in and to the Program 
(including but not limited to video, audio and other content 
incorporated therein) and title to any and all copies thereof 
are owned by Codemasters or its licensors, and you receive 
no right or interest therein other than the limited license in 
paragraph 1 hereof.

YOU SHALL NOT:

* Copy the Program.

* Sell, rent, lease, license, distribute or otherwise transfer or make 
available to any other person the Program, in whole or in part, or 
use the Program or any part thereof in any commercial context, 
including but not limited to using in a service bureau, “cyber 
cafe”, computer gaming centre or any other commercial location 
in which multiple users may access the Program. Codemasters 
may offer a separate Site License Agreement to permit you to 
make the Program available for commercial use; see the contact 
information below.

* Reverse engineer, derive source code, modify, decompile, 
disassemble, or create derivative works of the Program, in 
whole or in part.

* Remove, disable or circumvent any proprietary notices or 
labels contained on or within the Program.

LIMITED WARRANTY. Codemasters warrants to the original 
consumer purchaser of the Program that the recording medium 
on which the Program is recorded will be free from defects in 
material and workmanship for 90 days from the date of purchase. 
If the recording medium of a product is found defective within 90 
days of original purchase, Codemasters agrees to replace, free of 
charge, such product within such period upon its receipt of the 
Product, postage paid, with proof of the date of purchase, as long 
as the Program is still being manufactured by Codemasters. In 
the event that the Program is no longer available, Codemasters 
retains the right to substitute a similar program of equal or 
greater value. This warranty is limited to the recording medium 
containing the Program as originally provided by Codemasters 
and is not applicable and shall be void if the defect has arisen 
through abuse, mistreatment, or neglect. Any implied warranties 
prescribed by statute are expressly limited to the 90-day period 
described above.

EXCEPT AS SET FORTH ABOVE, THIS WARRANTY IS IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER ORAL OR WRITTEN, EXPRESS 
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY, 
SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE OR 
NON-INFRINGEMENT, AND NO OTHER REPRESENTATIONS OR CLAIMS 
OF ANY KIND SHALL BE BINDING ON OR OBLIGATE CODEMASTERS. 

When returning the Program for warranty replacement please 
send the original product discs only in protective packaging and 
include: (1) a photocopy of your dated sales receipt; (2) your 
name and return address typed or clearly printed; (3) a brief note 
describing the defect, the problem(s) you encountered and the 
system on which you are running the Program.

LIMITATION ON DAMAGES. IN NO EVENT WILL CODEMASTERS BE 
LIABLE FOR SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
RESULTING FROM POSSESSION, USE OR MALFUNCTION OF 
THE PROGRAM, INCLUDING DAMAGES TO PROPERTY, LOSS OF 
GOODWILL, COMPUTER FAILURE OR MALFUNCTION AND, TO THE 
EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURIES, 
EVEN IF CODEMASTERS HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. CODEMASTERS’ LIABILITY SHALL NOT EXCEED 
THE ACTUAL PRICE PAID FOR THE LICENSE TO USE THIS PROGRAM. 
SOME STATES/COUNTRIES DO NOT ALLOW LIMITATIONS ON HOW 
LONG AN IMPLIED WARRANTY LASTS AND/OR THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 
THE ABOVE LIMITATIONS AND/OR EXCLUSION OR LIMITATION OF 
LIABILITY MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS WHICH 
VARY FROM JURISDICTION TO JURISDICTION.

TERMINATION. Without prejudice to any other rights of Codemasters, 
this Agreement will terminate automatically if you fail to comply 
with its terms and conditions. In such event, you must destroy all 
copies of the Program and all of its component parts.

INJUNCTION. Because Codemasters would be irreparably 
damaged if the terms of this Agreement were not specifically 
enforced, you agree that Codemasters shall be entitled, without 
bond, other security or proof of damages, to appropriate equitable 
remedies with respect to breaches of this Agreement, in addition 
to such other remedies as Codemasters may otherwise have 
under applicable laws.

INDEMNITY. You agree to indemnify, defend and hold Codemasters, 
its partners, affiliates, contractors, officers, directors, employees 
and agents harmless from all damages, losses and expenses 
arising directly or indirectly from your acts and omissions to act 
in using the Program pursuant to the terms of this Agreement.

MISCELLANEOUS. This Agreement represents the complete 
agreement concerning this license between the parties and 
supersedes all prior agreements and representations between 
them. It may be amended only by a writing executed by 
both parties. If any provision of this Agreement is held to be 
unenforceable for any reason, such provision shall be reformed 
only to the extent necessary to make it enforceable and the 
remaining provisions of this Agreement shall not be affected. This 
Agreement shall be governed by and construed in accordance 
with the laws of England and you consent to the exclusive 
jurisdiction of the courts of England.

If you have any questions concerning this license, you may contact Codemasters at: 

The Codemasters Software Company Limited, PO Box 6, 
Royal Leamington Spa, Warwickshire, CV47 2ZT, United Kingdom. 

Tel +44 1926 814 132    Fax +44 1926 817 595
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TECHNICAL SUPPORT

Codemasters Website 

www.codemasters.co.uk

Codemasters’ website contains game patches, FAQs and an online version of our technical 
support knowledgebase. It also has a technical support request form that you can use to 
request assistance with this or any other Codemasters game.

Email

custservice@codemasters.com

Please include your Dxdiag.txt file with a description of your problem. To obtain this file, 
click the START button on your Windows Taskbar, then click RUN. Type ‘Dxdiag’ in the 
dialog box that opens and click OK. This will display the DirectX Diagnostics screen. To send 
the results, simply click the “SAVE ALL INFORMATION” button and save this as a text (.txt) 
file. Now attach this file to your email.

Email support is provided 7 days a week.

Telephone / Fax

Before calling, ensure that you have checked our website for a possible solution and  
have read the Toca Race Driver™3 help file which can be found on the Toca Race Driver™3 
DVD-ROM.

To access the help file:

1. Double-click on “MY COMPUTER” on your Windows Desktop.

2. Right-click on your DVD-ROM drive.

3. Left-click on “EXPLORE”.

4. Double-click on “README”.

Tel:  (from within UK) 0870 75 77 881 
 (from outside UK) 0044 1926 816044

Lines are open: 
1300-1800 Monday, Wednesday and Friday,  
1400-2000 Tuesday and Thursday.

Please ensure that you are in front of your PC before calling. Your PC should also be  
on and in a running state (ie. not having just crashed). Calls may be recorded for  
training purposes.

Codemasters Postal Address 

Customer Services, Codemasters Software Ltd,  
PO Box 6, Royal Leamington Spa, Warwickshire, CV47 2ZT, UK.



before you call, read through these step-by-step directions…

1 In your game, go to Main Menu > Options > Bonus > Unlocking information and write 
down the Bonus Access Code. You need this to access the Bonus Codes.

2 Log on or call the Hintline on the number above and follow the directions to the ToCA 
Race Driver™3 area. 

3  When requested, enter the Bonus Access Code you obtained in Step 1.

4  If you’re buying the Codes online (£2.99 paid by credit card / PayPal), the full set 
will be emailed to you. If you are calling the Hintline, write down the codes as they are 
read to you; you can access as many or as few Bonus Codes in one call as you like.

5 To unlock the Bonuses, go to Main Menu > Options > Bonus and enter the Code/s 
you’ve been given.

*Requires touch tone telephone and ToCA Race Driver™3 save file.

Calls cost £1 per minute. Calls from mobiles vary. Callers must be over 16 and have permission from the bill payer.  
Prices correct at time of going to press..

Bonus Codes

To obtain these bonus codes log onto

www.codemasters.co.uk/bonuscodes
or call

0904 445 0044

■  Unlock all the championships in the game

■  Unlock extra, bonus championships

■  Leave the opposition standing with the speed boost

■  Unlock and race high speed toy cars

■  Get into the groove and race in the slot racing championship

■  Make your car impervious to damage and deal out some  
punishment

Cheats affecting car performance/damage cannot be used whilst playing online.

Note: all of these can also be unlocked by playing through the game.

5024866329872 
PRD3CDUK05


